
MicroApp Manager help index

The index lists the Help topics available for MicroApp Manager.    Use the scroll bar to see entries not 
currently visible in the Help window.    To learn how to use help, press F1 or choose Using Help from 
the Help menu. 

Keyboard 
Using MicroApp Manager with a keyboard

Commands
About MicroApp Manager...
Initial Launch...
Load MicroApp...
Options...
Quick Launch...
Remove All MicroApps
Remove MicroApp Manager
Run MicroApp...

Dialog Boxes
Command Line Parameters
Initial Launch
Load MicroApp
MicroApp Manager Options
Quick Launch
Run MicroApp

Procedures
Automatically starting MicroApp Manager
Changing the MicroApp Manager menu
Closing a MicroApp
Closing all MicroApps
Closing all MicroApps and the MicroApp Manager
Loading a MicroApp
Positioning the MicroApp Manager icon
Prompting for MicroApp parameters
Running a MicroApp
Specifying the MicroApp path
Starting a MicroApp
Starting MicroApps automatically



Using MicroApp Manager with a keyboard

Use the following keyboard commands with MicroApp Manager.    For more information about using 
Windows with a keyboard, see Windows Help.

Menu keys

ALT+letter Chooses the menu bar whose underlined letter matches the one you type. 
In Icon Designer, for example, pressing ALT+F chooses the File menu.

Letter Chooses the command on the drop-down menu whose underlined letter 
matches the one you type.    In Icon Designer, for example, pressing O 
chooses the Open command from the File menu.

ARROW KEYS Moves between menu items.

ENTER Chooses the selected menu item.

ESC Cancels the selected menu.    The drop-down menu disappears.

Dialog box keys

TAB Moves from option to option (left to right and top to bottom).

SHIFT+TAB Moves from option to option in reverse order.

ALT+letter Moves to the option whose underlined letter matches the one you type.    
For example, in the Run MicroApp dialog box, ALT+M chooses the Run 
Minimized option.

DIRECTION KEY Moves between selections within a group of options, or moves up and 
down through the items in a list box or text box.

ALT+DOWN ARROW Opens a drop-down list box

SPACEBAR Selects an item in a list box, checks or unchecks a checkbox, or chooses 
the current selection in a group of options.

SHIFT+DIRECTION KEY Extends the selection in a list box.

ENTER Executes all of the currently selected options and list items in a dialog 
box.

ESC Closes a dialog box without completing the command.

Help keys

F1 Displays the Help window, with the Help index for the application.    If you 
have chosen a command or you are in a dialog box, the Help text for the 
command or dialog box will be displayed instead.    If the Help window is 
already open, F1 takes you back to the index.

Window keys

ALT+SPACEBAR Opens the Control menu for the active window.

ALT+F4 Closes the active window.

ALT+ESC Switches to the next application window or icon.



MicroApp Manager commands

MicroApp Manager is the software "engine" that lets you customize how you work with MicroApps.    
Use the commands on the MicroApp Manager menu to install, run, and manage your MicroApps, 
including:

* Starting MicroApps.
* Launching MicroApps automatically.
* Changing the list of MicroApps that appear on the MicroApp Manager menu.
* Closing your MicroApps.

The topics listed below provide information about MicroApp Manager's commands.

About MicroApp Manager...
Initial Launch...
Load MicroApp...
Options...
Quick Launch...
Remove All MicroApps
Remove MicroApp Manager
Run MicroApp...



MicroApp Manager procedures

The topics listed below provide step-by-step instructions for using MicroApp Manager.

Automatically starting MicroApp Manager
Changing the MicroApp Manager menu
Closing a MicroApp
Closing all MicroApps
Closing all MicroApps and the MicroApp Manager
Loading a MicroApp
Positioning the MicroApp Manager icon
Prompting for MicroApp parameters
Running a MicroApp
Specifying the MicroApp path
Starting a MicroApp
Starting MicroApps automatically



MicroApp Manager dialog boxes

The topics listed below describe each of the dialog boxes in MicroApp Manager.

Command Line Parameters
Initial Launch
Load MicroApp
MicroApp Manager Options
Quick Launch
Run MicroApp



Run MicroApp... command

This command lets you choose the MicroApps that you want to run as an application window.

Related topics
Run MicroApp dialog box
Running a MicroApp



Run MicroApp dialog box

This dialog box displays a list of the available MicroApps.    Highlight the MicroApp you want to run as a 
window, and choose OK to run it.    You may choose to run as many MicroApps as you wish. 

Related topics
Run MicroApp... command
Running a MicroApp



Command Line Parameters dialog box

This dialog box allows you to pass a command line parameter to the MicroApp which is about to be 
run.    For example, if you are using a MicroApp that can open files (such as Art Gallery), a parameter 
can tell it which file to open. 

To specify a parameter, type it in the text box and press ENTER or choose OK.    To run the MicroApp 
without a parameter, simply press ENTER.

Related topics
Options... command
Prompting for MicroApp parameters



Load MicroApp... command

This command lets you choose the MicroApps that you want to load as an icon.

Related topics
Load MicroApp dialog box
Loading a MicroApp



Load MicroApp dialog box

This dialog box displays a list of the available MicroApps.    Highlight the MicroApp you want to load as 
an icon, and choose OK to load it.    You may choose to load as many MicroApps as you wish.

Related topics
Load MicroApp... command
Loading a MicroApp



Options... command

This command lets you configure MicroApp Manager, including where you want the MicroApp 
Manager icon to appear, and whether or not the parameter prompt appears each time you start certain 
MicroApps.    It also lets you specify the path for your MicroApps.

Related topics
MicroApp Manager Options dialog box
Positioning the MicroApp Manager icon
Prompting for MicroApp parameters
Specifying the MicroApp path



MicroApp Manager Options dialog box

Use this dialog box to configure MicroApp Manager, including where you want the MicroApp Manager 
icon to appear, whether or not the parameter prompt appears each time you start certain MicroApps, 
and the path for your MicroApps.

Tear Off Turn this option on to have the MicroApp Manager appear as an icon 
that you can position on the screen wherever you want.

All Applications Turn this option on if you want the MicroApp Manager menu icon to 
replace the Control menu in every application window.    This is the 
default setting.

MicroApp Path Use this text box to specify the path containing your MicroApps.    If 
your MicroApps are stored in more than one directory, you can enter 
multiple paths by separating them with a semicolon. 

Prompt for
MicroApp parameters Turn this option on if you want to be prompted for a MicroApp 

parameter each time you start certain MicroApps.    You can use a 
parameter to tell a MicroApp what you want it to do.    For example, if 
you are using a MicroApp that can open files (such as Art Gallery), a 
parameter can tell it which file to open. 

Choose OK to save your changes, or choose Cancel to escape. 

Related topics
Options... command
Positioning the MicroApp Manager icon
Prompting for MicroApp parameters
Specifying the MicroApp path



Quick Launch... command

This command lets you choose which MicroApps are displayed on the MicroApp Manager menu, as 
well as the order in which they are displayed.    You can display all of the MicroApps currently installed, 
or only those you wish.

Related topics
Changing the MicroApp Manager menu
Quick Launch dialog box



Quick Launch dialog box

Use this dialog box to choose the MicroApps you want displayed on the MicroApp Manager menu, as 
well as the order in which they appear.

MicroApps Available Use this list box to highlight the MicroApps you want to add to the 
menu.    Select as many as you wish.

Add button Adds the currently-selected MicroApps to the MicroApps on Menu 
list box. 

MicroApps on Menu This shows what the MicroApp Manager menu will look like once you 
choose the OK button.    Use this list box to highlight the MicroApps 
you want to re-position or remove from the menu.

Remove button Removes the currently-selected MicroApps from the MicroApps on 
Menu list box.

Move Up and 
Move Down buttons These buttons change the position of the MicroAppscurrently 

highlighted in the MicroApps on Menu list box.

Describe button Displays a description of the MicroApps currently highlighted.

When you're finished editing the menu, choose OK to save your changes, or choose Cancel to 
escape. 

Related topics
Changing the MicroApp Manager menu
Quick Launch... command



Initial Launch... command

This command lets you choose which MicroApps will be launched automatically each time you start 
the MicroApp Manager. 

Related topics
Initial Launch dialog box
Starting a MicroApp automatically



Initial Launch dialog box

Use this dialog box to choose the MicroApps you want automatically launched each time you start the 
MicroApp Manager.

MicroApps Available Use this list box to highlight the MicroApps you want to launch 
automatically.    Select as many as you wish.

Add button Adds the currently-selected MicroApps to the MicroApps to Launch 
list box. 

MicroApps to Launch This list box shows which MicroApps will automatically be launched 
at startup, and whether they will be launched as a window 
("maximized"), or as an icon ("minimized").    Use this list box to 
highlight the MicroApps you want to re-position or remove from the 
list. 

Remove button Removes the currently-selected MicroApps from the MicroApps to 
Launch list box.

Move Up and 
Move Down buttons Use these buttons to specify the launch order of the MicroApps 

currently highlighted in the MicroApps to Launch list box.

As Window and 
As Icon buttons Specifies whether the MicroApps currently highlighted in the 

MicroApps to Launch list box are loaded as an icon ("minimized"), 
or run as a window ("maximized").

Describe button Displays a description of the MicroApps currently highlighted.

When you're finished editing the initial launch list, choose OK to save your changes, or choose Cancel 
to escape. 

Related topics
Initial Launch... command
Starting a MicroApp automatically



Remove All MicroApps command

This command closes any MicroApps that are currently running without removing MicroApp Manager 
from the System menu .    After you choose this command a prompt appears asking you to confirm 
your decision to exit.

Related topics
Closing all MicroApps



Remove MicroApp Manager command

This command removes MicroApp Manager and closes any MicroApps that are currently running.    
After you choose this command a prompt appears asking you to confirm your decision to exit.

Related topics
Closing all MicroApps and the MicroApp Manager



About MicroApp Manager... command

This command displays information about MicroApp Manager.    Use the Help button to get information 
about using MicroApp Manager.



Starting a MicroApp

There are three ways to start a MicroApp:

1. Running or loading them automatically when you start MicroApp Manager.
2. Using the Run... or Load... command from the MicroApp Manager menu.
3. By choosing it from the MicroApp Manager menu.

Related topics
Loading a MicroApp
Running a MicroApp
Starting a MicroApp automatically



Changing the MicroApp Manager menu

With MicroApp Manager, you choose which MicroApps are displayed on the menu, as well as the order 
in which they are displayed.    You can display all of the MicroApps installed, or only those you wish.

1. Click the hDC icon, and then choose the MicroApp Manager command to display the MicroApp 
Manager menu.

2. Choose the Quick Launch... command to display the Quick Launch dialog box.

3. Edit the list of MicroApps displayed in the MicroApps on Menu list box. 

To add to the list, select a MicroApp in the MicroApps Available list box and press the Add 
button.    To remove a MicroApp from the list, select it from the MicroApps on Menu list box, and 
press the Remove button.    If you're not sure what a particular MicroApp is used for, highlight its 
name and press the Describe button.

4. Specify the order in which you want the MicroApps to appear on the menu.    To change the order, 
highlight a MicroApp in the MicroApps on Menu list box and press the Move Up or Move Down 
button.

5. Choose OK to save your changes, or press Cancel to escape.

Related topics
Quick Launch dialog box
Quick Launch... command



Starting MicroApps automatically

You can instruct MicroApp Manager to automatically run MicroApps at startup using the Initial 
Launch... command.    You can also choose the order in which the MicroApps are started.

1. Click the hDC icon, and then choose the MicroApp Manager command to display the MicroApp 
Manager menu.

2. Choose the Initial Launch... command to display the Initial Launch dialog box.

3. Edit the list of MicroApps displayed in the MicroApps to Launch list box. 

To add to the list, highlight a MicroApp in the MicroApps Available list box, and press the Add 
button.      To remove a MicroApp from the list, highlight it from the MicroApps to Launch list box, 
and press the Remove button.    To display a description of what a MicroApp is used for, highlight 
its name and press the Describe button.

4. Specify the order in which you want the MicroApps to be launched, and whether they should be 
run as a window ("maximized") or loaded as an icon ("minimized"). 

To specify the order in which MicroApps are launched, highlight the name of the MicroApp in the 
MicroApps to Launch list box, and press the Move Up and Move Down buttons. 

By default, MicroApps are loaded as icons, as indicated by the letter "I" in the MicroApps to 
Launch list box.    To change this setting, highlight the name of the MicroApp and press the As 
Window or As Icon option.

5. Choose OK to save your changes, or press Cancel to escape.

Related topics
Initial Launch dialog box
Initial Launch... command



Running a MicroApp

To run a MicroApp as a window, you use the Run MicroApp... command. 

1. Click the hDC icon, and then choose the MicroApp Manager command to display the MicroApp 
Manager menu.

2. Choose the Run MicroApp... command to display the Run MicroApp dialog box.

3. Select the name of each MicroApp you want to run.    Select as many as you wish.

4. When you're finished, choose OK to run the selected MicroApps, or choose Cancel to escape.

Related topics
Run MicroApp dialog box
Run MicroApp... command



Loading a MicroApp

To load a MicroApp as an icon, you use the Load MicroApp... command. 

1. Click the hDC icon, and then choose the MicroApp Manager command to display the MicroApp 
Manager menu.

2. Choose the Load MicroApp... command to display the Load MicroApp dialog box.

3. Select the name of each MicroApp you want to load.    Select as many as you wish.

4. When you're finished, choose OK to load the selected MicroApps, or choose Cancel to escape.

Related topics
Load MicroApp dialog box
Load MicroApp... command



Positioning the MicroApp Manager icon

You can choose to have the MicroApp Manager icon replace the Control menu in every application 
window, or you can have it stand alone as an icon in the icon area. 

1. Click the hDC icon, and then choose the MicroApp Manager command to display the MicroApp 
Manager menu.

2. Choose the Options... command to display the MicroApp Manager Options dialog box.

3. Turn the All Applications option on to display the MicroApp Manager icon in every window, or 
use the Tear Off option to display it in the icon area.

4. Choose OK to save your changes, or choose Cancel to escape.

Related topics
MicroApp Manager Options dialog box
Options... command



Prompting for MicroApp parameters

One of MicroApp Manager's options lets you bring up a dialog box to specify a parameter each time 
you start certain MicroApps. For example, if you are using a MicroApp that can open files (such as Art 
Gallery), a parameter can tell it which file to open. 

1. Click the hDC icon, and then choose the MicroApp Manager command to display the MicroApp 
Manager menu.

2. Choose the Options... command to display the MicroApp Manager Options dialog box.

3. Turn the Prompt for MicroApp Parameters option on. 

4. Choose OK.

Related topics
Command Line Parameters dialog box
MicroApp Manager Options dialog box
Options... command



Specifying the MicroApp path

The installation program copies your MicroApps into a specific directory.    If you later move them to 
another directory, you must tell MicroApp Manager where to find them.

1. Click the hDC icon, and then choose the MicroApp Manager command to display the MicroApp 
Manager menu.

2. Choose the Options... command to display the MicroApp Manager Options dialog box.

3. Type the search path for your MicroApps in the MicroApp Path text box.    For example, if your 
MicroApps are in a directory called \MICROAPPS on your C: drive, you would type C:
\MICROAPPS.

If your MicroApps are stored in more than one location, separate each path with a semicolon.

4. Choose OK to save your changes, or choose Cancel to escape.

Related topics
MicroApp Manager Options dialog box
Options... command



Closing a MicroApp

1. Display the MicroApp menu by clicking the MicroApp icon, or choosing its Control menu.

2. Choose the Close command.

Related topics
Closing all MicroApps
Closing all MicroApps and the MicroApp Manager



Closing all MicroApps

The following procedure closes all open MicroApps without removing the MicroApp Manager.

1. Click the hDC icon, and then choose the MicroApp Manager command to display the MicroApp 
Manager menu.

2. Choose the Remove All MicroApps command.    You will be asked to confirm that you want to 
close all of the MicroApps currently open.

Related topics
Closing a MicroApp
Closing all MicroApps and the MicroApp Manager



Closing all MicroApps and the MicroApp Manager

The following procedure closes all open MicroApps and removes the MicroApp Manager.

1. Click the hDC icon, and then choose the MicroApp Manager command to display the MicroApp 
Manager menu.

2. Choose the Remove MicroApp Manager command.    You will be asked to confirm that you want 
to close the MicroApp Manager.

Related topics
Closing a MicroApp
Closing all MicroApps



Automatically starting MicroApp Manager

You can set MicroApp Manager to start automatically whenever you start Windows.    This displays the 
MicroApp Manager icon and starts any MicroApps that have been chosen using the Initial Launch... 
command.

1. Make a system diskette that includes a backup copy of your WIN.INI file.

2. Change the load= line in your WIN.INI file to read load=microman.    You can modify your WIN.INI 
file using a text editor such as Windows Notepad.

3. Save the changes to your WIN.INI file.

4. Exit and restart Windows.

Related topics
Initial Launch... command



active

The window that will be affected by the next keystroke or command.    If a window is active, its title bar 
changes color so that you can see it easily.



application

A program that accomplishes a specific task, such as a word processor or spreadsheet.



batch file

A text file with the extension .BAT that contains DOS commands.



cascade

A way to arrange open windows on the desktop so that they are overlapping    (See also "Tile.").



checkbox

A square in a dialog box that you can choose to select an option.    If the option is chosen, an X will 
appear in the checkbox.



click

To press and release the mouse button to execute an action.



clipboard

A special Windows facility for transferring information from one application to another.    When you cut or 
copy information from an application it goes into the clipboard.    When you paste information, it is copied 
from the clipboard to the active window.



Control menu

The menu on most windows and some dialog boxes that appear in the upper left corner of every window, 
represented by a small horizontal bar.    The Control menu lets you move, resize, and close the window 
or dialog box.



desktop pattern

A geometric pattern that appears on the desktop.



dialog box

A special window that appears on the screen when you are using a command.    The dialog box    lets you 
make choices and select options for the command you are using.



direction keys

The four arrow keys on the keyboard, used to move up, down, left, and right.



directory

A collection of files and/or subdirectories. 



document

A file created with an application.



DOS search path

A list of the directories where DOS and Windows will look for an application if it is not located in the 
current directory.    The path can be set with the DOS PATH command, which can be placed in the 
AUTOEXEC.BAT file.



double click

To quickly press and release the mouse button twice in succession to execute an action.



drag

To move the mouse pointer while you are holding down the mouse button.



drop-down menu

A list of command choices which can be displayed when you drag the mouse down from the menu bar or 
press the ALT key along with the underlined letter on a menu choice.



executable file

A DOS or Windows program file with the filename extension .EXE.



filename

The name of a document.    A filename can have up to eight alphanumeric characters, plus an extension. 
An extension begins with a period and can have up to three characters.    Normally, the extension 
indicates the type of file.    For example, files with the extension .BAT are batch files.



keyword

An underlined word or phrase appearing in a Help description      Press and hold down SHIFT and 
ENTER to display its definition.



list box

A box within a dialog box from which you choose an item.    such as file or directory names.    Use mouse 
or DIRECTION keys to highlight items.    If there are more items than can fit in the box at once, you can 
use the scroll bar to see the rest of the list.



maximize

To enlarge the application in the active window or icon to fill the screen.



menu bar

The horizontal bar at the top of a window, which contains the names of the application's menus.    Use 
the mouse or ALT+the underlined letter key to drop-down command menus.



MicroApp Manager icon 

The small red box with the letters "hDC" inside.    The icon is used to access the MicroApp Manager 
menu.



minimize

To shrink the active window to an icon.



non-Windows application

An application that does not require Microsoft Windows in order to run.



option button

A small circle in a dialog box that can be selected to choose an option.    The option is selected if the 
option button is filled in.    To choose an option, click the button with the mouse or use the TAB key to 
move to the option and use the SPACEBAR to select it.



overlap

A way to arrange windows on the desktop, so that they partially cover one and other    (See also 
"Cascade.")



parameter

Information used to tell an application what to do when it is started.    For example, you could pass a 
parameter telling a MicroApp which file you want it to open. 



path

The drive letter and directory name where a file resides.    For example, C:\WINDOWS. 



pathname

The name and location of a file, including the filename, directory, and drive letter.    A full pathname 
includes a drive letter followed by a colon, one or more directory names separated by a backslash (\), 
and a filename.    For example, C:\WINDOWS\WRITE.EXE.



PIF (Program Information File)

A program information file.    This is a special file created for non-Windows applications so that they can 
be run from Windows.



restore

To use the Restore button or command to return a window or icon to its previous size.



scroll

To move the contents of a window or dialog box up, down, left, or right.



scroll bar

A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible. 
Each scroll bar contains two scroll arrows and a scroll box, which allow you to scroll within the window or 
list box.



text box

A box within a dialog box where you type text, such as a filename.



tile

A way to arrange open windows on the desktop, so that they do not overlap.



Windows application

An application that requires Microsoft Windows in order to run and which takes advantage of the 
Windows graphical user interface.


